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SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product
Name

HP 4320t Mobile Thin Client, UMA

Processors Intel® Arrandale™ P4500, 1.8-GHz, 3-MB L3 cache (35 W)

Chipsets Intel® HM57 Express

Graphics Intel® HD Graphics

Universal Memory Architecture (UMA) graphics subsystem integrated with shared video memory
(dynamically allocated)

Panels All display panel assemblies support privacy filter

LED backlight, 33.8-cm (13.3-in) HD (1366×768 resolution)

Memory 2 customer-accessible/upgradable SODIMM memory module slots

Supports dual-channel memory

Supports up to 8 GB of system memory in all countries and regions

PC3-10600, 1333-MHz, DDR3

Supports the following configurations in all countries and regions:

● 4096-MB total system memory (2048-MB × 2, dual channel)

● 3072-MB total system memory (2048-MB + 1024-MB, dual channel)

● 2048-MB total system memory (2048-MB × 1)

● 2048-MB total system memory (1024-MB × 2, dual channel)

● 1024-MB total system memory (1024-MB × 1)

Primary storage Serial ATA, solid-state module

Supports the following storage:

● 2-GB

● 4-GB

● 8-GB

Optical
drives

Fixed DVD-ROM drive

12.7-mm (0.50-in) tray load

Supports option of no optical drive
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Category Description

Diskette
drive

Supports external USB diskette drive only

Audio/
Visual

HD audio - IDT 92HD80

Integrated microphone

Two stereo speakers

Headphone/microphone jacks

Modem High-speed 56k modem for all regions and countries

Modem cable not included

Supports no-modem option

Ethernet 10/100/1000 Ethernet network interface card (NIC)

S3/S4/S5 wake on LAN (AC only mode)

Ethernet cable not included

Wireless Integrated WLAN options by way of wireless module:

Support for the following WLAN formats:

● Broadcom 802.11a/b/g/n 2×2

● Broadcom 802.11b/g

2 WLAN antennas built into display assembly

Support for no-WLAN option

External media
cards

One ExpressCard slot (34 mm)

Media Card Reader supporting Memory Stick (MS), Memory Stick Pro (MSP), Secure Digital (SD)
Memory Card, Secure Digital High Capacity (SDHC) Memory Card, MultiMediaCard (MMC), and xD-
Picture Card formats

Ports Audio-in (stereo microphone)

Audio-out (stereo headphone)

RJ-11 (modem)

RJ-45 (Ethernet, includes link light and activity lights)

USB 2.0 (3)

eSATA/USB 2.0 combo

HDMI

VGA (Dsub 15-pin) supporting 1600×1200 external resolution at 75-GHz (hot plug/unplug with auto-
detect)

Multi-pin AC power

Keyboard and
pointing
devices

33.8-cm (13.3-in) keyboard with TouchPad

TouchPad supports 2-way scroll with legend; taps enabled as default
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Category Description

Power
requirements

65-W Smart AC Adapter with localized cable plug support (3-wire plug with ground pin)

9-cell, 93-Wh Li-ion battery

6-cell, 47-Wh Li-ion battery

Security Supports security cable

Intel anti-theft support

Operating
system

Preinstalled:

Windows® Embedded Standard 7

Windows® Embedded Standard 2009

Web Support:

Windows® Embedded Standard 7

Windows® Embedded Standard 2009

Serviceability End-user replaceable parts:

AC adapter

Battery (system)

Keyboard

Solid-state module

Memory module

DVD-ROM drive

WLAN module
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2 External component identification

Top components
TouchPad

Component Description

(1) TouchPad off indicator To turn the TouchPad zone on and off, quickly double-tap the
TouchPad off indicator.

NOTE: When the TouchPad zone is active, the light is off.

(2) TouchPad zone Moves the pointer and selects or activates items on the screen.

(3) Left TouchPad button* Functions like the left button on an external mouse.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start  > Control Panel  >
 Mouse.
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Lights

Component Description

(1) TouchPad off indicator ● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(2) Caps lock light On: Caps lock is on.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off.

(4) Wireless light ● White: An integrated wireless device is on, such as a
wireless local area network (WLAN) device.

● Amber: All wireless devices are off.
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Buttons, speakers, and switches
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Speakers (2) Produce sound.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state, press the button
briefly to exit Sleep.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings and how to change
them, select Start > Control Panel  > Power Options.
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Keys

Component Description

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when
pressed in combination with a function key or the esc
key.

(3) Windows logo key Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when
pressed in combination with the fn key.

(5) Windows applications key Displays a shortcut menu for items beneath the
pointer.

(6) Embedded numeric keypad keys Can be used like the keys on an external numeric
keypad, when pressed in combination with the fn and
num lk keys.

(7) Wireless key Turns the wireless feature on or off.

NOTE: This key does not establish a wireless
connection. To establish a wireless connection, a
wireless network must be set up.
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Front components

Component Description

(1) Drive light ● Blinking white: The solid-state module or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the solid-
state module.

(2) Media Card Reader Supports the following optional digital card formats:

● Memory Stick

● Memory Stick Duo (adapter required)

● Memory Stick Pro (adapter required)

● MultiMediaCard (MMC)

● Secure Digital (SD) Memory Card

● xD-Picture Card (XD)

● xD-Picture Card (XD) Type H

● xD-Picture Card (XD) Type M

(3) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, refer to the Regulatory, Safety,
and Environmental Notices.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.
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Right-side components

Component Description

(1) USB 2.0 ports (2) Connect optional USB devices.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) Optical drive light (select models only) Blinking: The optical drive is being accessed.

(4) Optical drive eject button (select models
only)

Press to eject the optical disc.

(5) Optical drive (select models only) Reads optical discs.
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Left-side components

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) Battery light ● Amber: A battery is charging.

● White: A battery is close to full charge capacity.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) RJ-45 (network) jack Connects a network cable.

(7) HDMI port Connects an optional HDMI device.

(8) Combo eSATA/USB port Connects an optional USB device or high-performance eSATA
components, such as an eSATA external solid-state module.

(9) USB port Connects optional USB device.

(10) ExpressCard slot Supports optional ExpressCards.
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Bottom components

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.
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Display
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Internal microphone Records sound.
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Wireless antennas (select models only)
The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component Description

WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLANs).

*For optimal transmission, keep the areas immediately around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennas (select models only) 13



Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) Battery* Powers the computer when the computer is not plugged into an
external power source.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

Component Description

(1) Product name The product name affixed to the front of your computer.

(2) Serial number (s/n) An alphanumeric number that is unique to each
product.

(3) Part number/Product number (p/n) The number that provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period The duration of the warranty period for this computer.

(5) Model description The alphanumeric identifier you need to locate
documents, drivers, and support for your computer.
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Computer major components

Item Description Spare part number

(1) 33.8-cm (13.3-in) high-definition (1366x768 resolution) display assembly (see Display
assembly components on page 20 for more information on display assembly spare
parts).

599553-001

(2) Switch cover 599567-001

(3) Keyboard (includes keyboard cable)
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Item Description Spare part number

 ● For use in Belgium 599572-A41

 ● For use in Brazil 599572-201

 ● For use in Bulgaria 599572-261

 ● For use in Canada (French) 599572-121

 ● For use in Denmark 599572-081

 ● For use in Europe 599572-B31

 ● For use in France 599572-051

 ● For use in Germany 599572-041

 ● For use in Greece 599572-DJ1

 ● For use in Hungary 599572-211

 ● For use in Iceland 599572-DD1

 ● For use in Israel 599572-BB1

 ● For use in Italy 599572-061

 ● For use in Japan 599572-291

 ● For use in South Korea 599572-AD1

 ● For use in Latin America 599572-161

 ● For use in Norway 599572-091

 ● For use in Portugal 599572-131

 ● For use in Russia 599572-251

 ● For use in Saudi Arabia 599572-171

 ● For use in Spain 599572-071

 ● For use in Sweden and Finland 599572-B71

 ● For use in Switzerland 599572-BG1

 ● For use in Taiwan 599572-AB1

 ● For use in Thailand 599572-281

 ● For use in the Adriatic region 599572-BA1

 ● For use in the United Kingdom 599572-031

 ● For use in the United States 599572-001

 ● For use in Turkey 599572-141

(4) Palm rest (includes TouchPad) 599551-001

(5) Top heat shield/bracket (included with top cover)  

(6) Top cover 599569-001

(7) Power button board with cable 599517-001

(8) Speakers 599566-001
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Item Description Spare part number

(9) Fan 599544-001

(10) Processor heat sink 599546-001

(11) Memory module (PC3-10600, 1333-MHz, DDR3, shared)  

 2048-MB 598856-002

 1024-MB 598859-002

(12) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit. See Cable Kit on page 22 for more
Cable Kit spare part information.

 

 High-speed 56K modem for use in all countries and regions except Australia and New
Zealand

510100-001

 High-speed 56K modem for use in Australia and New Zealand 510100-011

(13) RTC battery 599516-001

(14) WLAN module  

 Broadcom 4312G 802.11b/g WiFi Adapter  

 For use in Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, the United
States, and the U.S. Virgin Islands

504593-003

 For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Belarus, Belgium, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal,
Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zambia, and Zimbabwe

504593-004

 Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter  

 For use in Antigua and Barbuda, Aruba, Bahamas, Barbados, Belize, Canada, Guam,
Guinea, Haiti, Jamaica, Nether Antilles, Puerto Rico, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, the United States, and the U.S. Virgin Islands

582564-001
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Item Description Spare part number

 For use in Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, Armenia, Australia,
Austria, Azerbaijan, Bahrain, Belarus, Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia
and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman Islands, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New
Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal,
Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-002

(15) Processor (Intel® Arrandale™ P4500 1.8-GHz, includes replacement thermal material) 611699-001

(16) RJ-11 (modem) jack and cable 

See Cable Kit on page 22 for more Cable Kit spare part information.

 

(17) USB connector board and cable 599524-001

(18) System board (includes replacement thermal material) 614524-001

(19) Power connector and cable

(DC power) See Cable Kit on page 22 for more Cable Kit spare part information.

 

(20) Battery  

 9-cell, 93-Wh (2.8-Ah) Li-ion 593573-001

 6-cell, 47-Wh (2.2-Ah) Li-ion 593572-001

(21) Base enclosure 599514-001

(22) ExpressCard slot bezel (included in Plastics Kit, see Plastics Kit on page 21)  

(23) Solid-state module (includes bracket)

 2-GB 614527-001

 4-GB 614528-001

 8-GB 634653-001

(24) DVD-ROM drive (includes bezel) 599539-001
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Display assembly components

Item Description Spare part number

 Display assembly: 599553-001

(1) Display bezel 599532-001

(2) Display panel (available separately in APJ, using part number 623175-001)  

(3) Display Hinge Kit (includes display hinges and left and right panel brackets) 599536-001

(4) Display cable and microphone 605557-001

(5) 2 WLAN antennas and cables (included with back cover)  

(6) Display back cover (includes 2 WLAN antennas and cables and 1 microphone) 599526-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 599563-001

(1) ExpressCard slot bezel 

(2) DVD-ROM drive blank (used with no-ODD option)

 RJ-11 (modem) connector blank (not illustrated, used with no-modem option)

Plastics Kit 21



Cable Kit

Item Description Spare part number

 Cable Kit: 599525-001

(1) Power connector and cable  

(2) RJ-11 (modem) jack and cable  
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Mass storage devices

Item Description Spare part number

(1) Solid-state module (includes bracket)

 2-GB 614527-001

 4-GB 614528-001

 8-GB 634653-001

(2) DVD-ROM drive (includes bezel) 599539-001
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Miscellaneous parts
Description Spare part number

AC adapters

65-W, 3-pin Smart AC adapter  

● For use in all countries and regions except India 609939-001

● For use in India 609948-001

Power cords (AC power, 3-pin, black, 1.83 m)

● For use in Argentina 490371-D01

● For use in Austria 490371-011

● For use in Brazil 490371-202

● For use in Denmark 490371-081

● For use in Europe 490371-021

● For use in India 490371-D61

● For use in Israel 490371-BB1

● For use in Italy 490371-061

● For use in Japan 490371-291

● For use in North America 490371-001

● For use in the People's Republic of China 490371-AA1

● For use in South Africa 490371-AR1

● For use in South Korea 490371-AD1

● For use in Switzerland 490371-111

● For use in Taiwan 490371-AB1

● For use in the United Kingdom and Singapore 490371-031

Rubber Kit  (includes display bumpers, display screw covers, base enclosure feet, and display
hinge bumpers)

599564-001

Screw Kit, includes:

● Slotted T8 M2.5x6.5

● Slotted T8 M2.5x5.0

● Slotted T8 M2.5x3.0

● P1 M2.5x5.0

● P1 M2.5x3.0

● P1 M2.0x3.0

● P0 M2.0x2.5

● PM3.0x3.5

599565-001

24 Chapter 3   Illustrated parts catalog



Sequential part number listing
Spare part
number

Description

490371-001 Power cord (AC power, 3-pin, black, 1.83 m), for use in North America

490371-011 Power cord (AC power, 3-pin, black, 1.83 m), for use in Austria

490371-021 Power cord (AC power, 3-pin, black, 1.83 m), for use in Europe

490371-031 Power cord (AC power, 3-pin, black, 1.83 m), for use in the United Kingdom and Singapore

490371-061 Power cord (AC power, 3-pin, black, 1.83 m), for use in Italy

490371-081 Power cord (AC power, 3-pin, black, 1.83 m), for use in Denmark

490371-111 Power cord (AC power, 3-pin, black, 1.83 m), for use in Switzerland

490371-202 Power cord (AC power, 3-pin, black, 1.83 m), for use in Brazil

490371-291 Power cord (AC power, 3-pin, black, 1.83 m), for use in Japan

490371-AA1 Power cord (AC power, 3-pin, black, 1.83 m), for use in the People's Republic of China

490371-AB1 Power cord (AC power, 3-pin, black, 1.83 m), for use in Taiwan

490371-AD1 Power cord (AC power, 3-pin, black, 1.83 m), for use in South Korea

490371-AR1 Power cord (AC power, 3-pin, black, 1.83 m), for use in South Africa

490371-BB1 Power cord (AC power, 3-pin, black, 1.83 m), for use in Israel

490371-D01 Power cord (AC power, 3-pin, black, 1.83 m), for use in Argentina

490371-D61 Power cord (AC power, 3-pin, black, 1.83 m), for use in India

504593-003 Broadcom 4312G 802.11b/g WiFi Adapter for use in Barbados, Belize, Canada, the Cayman Islands,
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504593-004 Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Belarus,
Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts
and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

510100-001 High-speed 56K modem for use in all countries and regions except Australia and New Zealand

510100-011 High-speed 56K modem for use in Australia and New Zealand
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Spare part
number

Description

582564-001 Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter, for use in Antigua and Barbuda, Aruba, Bahamas,
Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica, Nether Antilles, Puerto Rico, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, the United States, and the U.S. Virgin
Islands

582564-002 Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter, for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahrain, Belarus, Belgium, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman Islands, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Japan, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

593572-001 Battery, 6-cell, 47-Wh (2.2-Ah) Li-ion

593573-001 Battery, 9-cell, 93-Wh (2.8-Ah) Li-ion

598856-002 Memory module (PC3-10600 shared), 2048-MB

598859-002 Memory module (PC3-10600 shared), 1024-MB

599514-001 Base enclosure

599516-001 RTC battery

599517-001 Power button board with cable

599524-001 USB board and cable

599525-001 Cable Kit

599526-001 Display back cover (includes 2 WLAN antennas and cables and 1 microphone)

599532-001 Display bezel

599536-001 Display Hinge Kit (includes display hinges and left and right panel brackets)

599539-001 DVD-ROM drive

599544-001 Fan

599546-001 Processor heat sink

599551-001 Palm rest with TouchPad

599553-001 33.8-cm (13.3-in) HD (1366x768 resolution) display assembly

599563-001 Plastics Kit

599564-001 Rubber Kit
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Spare part
number

Description

599565-001 Screw Kit

599566-001 Speaker assembly

599567-001 Switch cover

599569-001 Top cover

599572-001 Keyboard, for use in the United States

599572-031 Keyboard, for use in the United Kingdom

599572-041 Keyboard, for use in Germany

599572-051 Keyboard, for use in France

599572-061 Keyboard, for use in Italy

599572-071 Keyboard, for use in Spain

599572-081 Keyboard, for use in Denmark

599572-091 Keyboard, for use in Norway

599572-121 Keyboard, for use in Canada (French)

599572-131 Keyboard, for use in Portugal

599572-141 Keyboard, for use in Turkey

599572-161 Keyboard, for use in Latin America

599572-171 Keyboard, for use in Saudi Arabia

599572-201 Keyboard, for use in Brazil

599572-211 Keyboard, for use in Hungary

599572-251 Keyboard, for use in Russia

599572-261 Keyboard, for use in Bulgaria

599572-281 Keyboard, for use in Thailand

599572-291 Keyboard, for use in Japan

599572-A41 Keyboard, for use in Belgium

599572-AB1 Keyboard, for use in Taiwan

599572-AD1 Keyboard, for use in South Korea

599572-B31 Keyboard, for use in Europe

599572-B71 Keyboard, for use in Sweden and Finland

599572-BA1 Keyboard, for use in the Adriatic region

599572-BB1 Keyboard, for use in Israel

599572-BG1 Keyboard, for use in Switzerland

599572-DD1 Keyboard, for use in Iceland

599572-DJ1 Keyboard, for use in Greece

605557-001 Display cable
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Spare part
number

Description

609939-001 65-W, 3-pin Smart AC adapter for use in all countries and regions except India

609948-001 65-W, 3-pin Smart AC adapter for use in India

611699-001 Processor (Intel® Arrandale™ P4500 1.8-GHz, includes replacement thermal material)

614524-001 System board

614527-001 2-GB solid-state module (includes bracket)

614528-001 4-GB solid-state module (includes bracket)

623175-001 Display panel (APJ only)

623987-001 Display bezel logo

634653-001 8-GB solid-state module (includes bracket)
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a solid-state module, shut down the computer.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a solid-state module, an optical drive, or a diskette drive, place it in a
static-proof bag.

Avoid exposing a solid-state module to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This section provides removal and replacement procedures.

There are as many as 83 screws, in 8 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

Component Description

(1) Product name The product name affixed to the front of your computer.

(2) Serial number (s/n) An alphanumeric number that is unique to each
product.

(3) Part number/Product number (p/n) The number that provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period The duration of the warranty period for this computer.

(5) Model description The alphanumeric identifier you need to locate
documents, drivers, and support for your computer.
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Computer feet

Description Spare part number

Rubber Kit (includes computer feet) 599564-001

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 599564-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

Battery  

9-cell, 93-Wh (2.8-Ah) Li-ion 593573-001

6-cell, 47-Wh (2.2-Ah) Li-ion 593572-001

Before disassembling the computer, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface with the battery bay toward you.

2. Slide the two battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover

Description Spare part number

Switch cover 599567-001

Before removing the switch cover, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

Remove the switch cover:

1. Position the computer upside down with the rear toward you.

2. Remove the four PM2.5×3.0 screws in the battery bay.

3. Turn the computer right-side up, and open the computer as far as possible.
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4. Slide the switch cover back (1), and then remove it from the computer (2).

Reverse this procedure to install the switch cover and keyboard.
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Keyboard

Description Spare part number

Keyboard (includes keyboard cable) 599572-xxx

NOTE: For a detailed list of keyboards see the parts list in Computer major components on page 16

Before removing the keyboard, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

Remove the keyboard:

1. Remove the four PM2.5×3.0 screws that secure the keyboard to the computer.
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2. Slide the keyboard back toward the display (1), and then rotate it right (2) until it rests upside
down on the right side of the computer.

3. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

4. Remove the keyboard (3).

Reverse this procedure to install the keyboard.
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Memory module

Description Spare part number

Memory module (PC3-10600, 1333-MHz, DDR3, shared)  

2048-MB 598856-002

1024-MB 598859-002

Before removing the memory module, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

6. Remove the keyboard (see Keyboard on page 39).

NOTE: You can release the keyboard without removing the keyboard cable from the system
board, and then rotate it right until it rests upside down on the right side of the computer to
remove the memory modules.

Remove the memory module:

1. Position the computer right-side up with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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DVD-ROM drive

Description Spare part number

DVD-ROM drive 599539-001

Before removing the DVD-ROM drive, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

6. Remove the keyboard (see Keyboard on page 39)

NOTE: You can release the keyboard without removing the keyboard cable from the system
board, and then rotate it left until it rests upside down on the left side of the computer to remove
the DVD-ROM drive.

Remove the DVD-ROM drive:

1. Position the computer with the right side toward you.

2. Remove the PM2.5×5.0 screw (1) that secures the DVD-ROM drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the access point on the top cover, and press
the DVD-ROM bracket (2) to the right to release the drive from the computer.

4. Remove the DVD-ROM drive (3) from the computer.
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5. If it is necessary to replace the DVD-ROM drive bracket, position the DVD-ROM drive with the
rear toward you.

6. Remove the two PM2.0×3.0 screws (1) that secure the DVD-ROM drive bracket to the DVD-
ROM drive.

7. Remove the DVD-ROM drive bracket (2).

Reverse this procedure to reassemble and install a DVD-ROM drive.
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Power button board

Description Spare part number

Power button board with cable 599517-001

Before removing the power button board, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

Remove the power button board:

1. Release the LIF (low insertion force) connector that connects the power button board cable to
the system board (1), and then disconnect the power button board cable (2).

2. Gently pull the power button board away from the double-sided tape that secures the board to
the base enclosure.

3. Remove the power button board (3).

Reverse this procedure to install the power button board.
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Speakers

Description Spare part number

Speaker assembly 599566-001

Before removing the speakers, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

6. Remove the keyboard.

Remove the speakers:

1. Position the computer right-side up with the front toward you.

2. Disconnect the speaker cable (1) from the system board.

NOTE: The two speakers are connected with a single cable.

3. Remove the two PM2.5×3.0 screws (2) that secure the speakers to the base enclosure.

4. Remove the speaker cable from the clips and routing channel.

5. Remove the tape holding the left speaker to the base enclosure.

6. Using a flat-bladed screwdriver, gently pry the left speaker from the base enclosure (3), lifting
the left speaker (4) up and away at an angle.

46 Chapter 4   Removal and replacement procedures



7. Slide the right speaker back and out from the tab (5) that holds it at the right, then lift the right
speaker (6) up and out at an angle.

Reverse this procedure to install the speakers.
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Palm rest

Description Spare part number

Palm rest (includes TouchPad) 599551-001

Before removing the palm rest, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the switch cover (see Switch cover on page 37).

6. Remove the keyboard (see Keyboard on page 39).

Remove the palm rest:

1. Position the computer right-side up with the front toward you.

2. Remove the three PM2.5×3.0 screws (1) that secure the palm rest to the computer.

3. Slide the palm rest to the right (2), and then turn it over from the front edge (3) until it rests
upside down on the top cover.

4. Release the TouchPad cable connector (1), and then remove the TouchPad cable (2) from the
system board.
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5. Remove the palm rest (3).

Reverse this procedure to install the palm rest.
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Solid-state module
NOTE: The solid-state module spare part kit includes a solid-state module bracket.

Description Spare part number

2-GB 614527-001

4-GB 614528-001

8-GB 634653-001

Before removing the solid-state module, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Palm rest (see Palm rest on page 48)

Remove the solid-state module:

1. Position the computer right-side up with the front toward you.

2. Remove the two PM2.0×2.5 screws (1) and loosen the PM2.5×10.0 captive screw (2) that
secures the solid-state module to the computer.

3. Grasp the Mylar tab on the solid-state module and slide the solid-state module (3) to the right to
disconnect it from the system board.
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4. Remove the solid-state module (4) from the solid-state module bay.

5. If it is necessary to replace the solid-state module bracket, remove the PM3.0×3.5 screws (1)
from each side of the solid-state module.

6. Lift the bracket (2) straight up to remove it from the solid-state module.

Reverse this procedure to reassemble and install the solid-state module.

Component replacement procedures 51



RTC battery

Description Spare part number

RTC battery 599516-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 36)

b. Switch cover (see Switch cover on page 37)

c. Keyboard (see Keyboard on page 39)

d. Palm rest (see Palm rest on page 48)

Remove the RTC battery:

1. Remove the tape from the top of the battery.

2. Remove the RTC battery from the system board.
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Reverse this procedure to install the RTC battery.
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WLAN module

Description Spare part number

Broadcom 4312G 802.11b/g WiFi Adapter  

For use in Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, the United States,
and the U.S. Virgin Islands

504593-003

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Belarus, Belgium, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgaria, Burkina
Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

504593-004

Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter  

For use in Antigua and Barbuda, Aruba, Bahamas, Barbados, Belize, Canada, Guam, Guinea,
Haiti, Jamaica, Nether Antilles, Puerto Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, the United States, and the U.S. Virgin Islands

582564-001

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, Armenia, Australia, Austria,
Azerbaijan, Bahrain, Belarus, Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Cayman Islands, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory
Coast, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama,
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

582564-002
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CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Palm rest (see Palm rest on page 48)

Remove the WLAN module:

1. Position the computer right-side up with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

3. Remove the two PM2.5×3.0 screws (2) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Heat sink and fan
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Fan 599544-001

Processor heat sink 599546-001

Before removing the heat sink, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Palm rest (see Palm rest on page 48)

Remove the heat sink:

1. Position the computer right-side up with the front toward you.

2. Remove the five PM2.5×3.0 screws (1) that secure the heat shield to the top cover.

3. Remove the two PM2.5×5.0 screws (2) that secure the heat shield to the top cover.
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4. Lift the right edge of the heat shield to disengage the tabs on the left side of the heat shield from
the top cover, and then remove the heat shield (3).

5. Disconnect the fan cable from the system board (1).

6. Loosen the 2.0×5.0 captive screw (2) from the system board, and then remove the fan (3).
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7. Following the sequence stamped into the heat sink, loosen the four PM2.5×10.0 captive screws
(1) that secure the heat sink to the processor.

8. Lift the heat sink off the processor (2), and then lift the heat sink up and to the right to remove
the heat sink from the base enclosure (3).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink, the
discrete system board (1) and (2), and the system board (3) and (4), each time the heat sink is
removed. Replacement thermal material is included with all heat sink, system board, and processor
spare part kits.

Reverse this procedure to install the heat sink and fan.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Processor, Intel Arrandale P4500 1.8-GHz, (includes replacement thermal material) 611699-001

Before removing the processor, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. DVD-ROM drive (see DVD-ROM drive on page 43)

d. Speakers (see Speakers on page 46)

e. Palm rest (see Palm rest on page 48)

f. Top cover (see Top cover on page 67)

g. Heat shield, heat sink, and fan (see Heat sink and fan on page 57)

Remove the processor:

1. Position the computer right-side up with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.
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3. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Display assembly
NOTE: The display assembly spare part kit includes 2 WLAN antennas and cables.

Description Spare part number

Display assembly, 33.8-cm (13.3-in) HD (1366x768 resolution) 599553-001

● Display bezel 599532–001

● Display panel (available separately in APJ, using part number 623175-001)  

● Display Hinge Kit (includes display hinges and left and right panel brackets) 599536-001

● Display cable and microphone 605557-001

● WLAN antennas and cables (included with display assembly)  

● Display back cover (includes 2 WLAN antennas and cables and 1 microphone) 599526-001

Before removing the display assembly, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Speakers (see Speakers on page 46)

d. Palm rest (see Palm rest on page 48)

e. WLAN cables (see WLAN module on page 54)

Remove the display assembly:

CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other computer components.

1. Disconnect the display cable from the system board (1), and remove all cables from the routing
channels along the top cover (2).

2. Remove the five T8 M2.5x6.0 screws and one PM 2.5x5.0 screw (3) that secure the display
assembly to the base enclosure.
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3. Lift the display assembly (4) straight up and remove it from the base enclosure.

4. If it is necessary to replace the display bezel, display enclosure, or display hinges, remove the
four Mylar screw covers (1) and the four slotted T8 M2.5×5.0 screws (2) that secure the display
bezel to the display assembly. The screw covers are available in the Rubber Kit, spare part
number 599564-001.

5. If it is necessary to replace the bezel, remove it as follows:

a. Flex the top of the bezel from the inside edge until it disengages from the display back
cover (1).

b. Flex the bottom of the bezel from the inside edge until it disengages from the display back
cover (2).
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c. Flex the inside edge of the left side and the right side of the bezel until it disengages from
the display back cover (3).

d. Remove the display bezel from the display back cover (4).

6. If it is necessary to replace the display hinges, remove the six T8 2.5x5.0 screws (1) that secure
the display hinges to the display panel. Lift the hinges (2) to remove them.

7. If it is necessary to replace the display panel, remove the two T8 2.5x3.0 screws (3) that secure
the top corners of the display panel to the top of the display back cover. Lift the top of the display
panel (4) away from the back cover at an angle.
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8. Peel back the tape (1) that secures the display cable to the display panel, and then release the
ZIF connector (2). Remove the cable from the display panel connector (3).

NOTE: The display cable includes the microphone.

9. Remove the display panel.

10. If it is necessary to replace the display brackets, remove the four PM2.0×3.0 screws (1) that
secure the display brackets to the display panel, and then remove the display brackets (2).
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11. Gently release the integrated microphone (1) from the clips at the top of the display back cover,
remove the display cable from the clips and routing channels (2) along the bottom of the display
back cover, and then remove the display cable (3).

12. If it is necessary to remove the wireless antennas and cables:

a. Detach the WLAN antennas (1) from the adhesive on the back cover, and then route the
cables through the clips (2) that secure the antenna cables to the display back cover.

b. Remove the wireless antennas and cables.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover 599569-001

Before removing the top cover, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Speakers (see Speakers on page 46)

d. DVD-ROM drive (see DVD-ROM drive on page 43)

e. Palm rest (see Palm rest on page 48)

Remove the top cover:

1. Position the computer right-side up with the front toward you.

2. Remove the 12 slotted T8 2.5×5.0 screws (1) and the 4 PM2.0×3.0 screws (2) that secure the
top cover to the base enclosure.

3. If installed, remove the ExpressCard slot bezel (1), and remove the tape that attaches the top
cover to the audio jacks.
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4. Release the top cover from the sides of the base enclosure , and gently use a flat-bladed
screwdriver to pry loose the top cover along the front edge (2).

5. Remove the top cover (3).

Reverse this procedure to install the top cover.
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Modem module

Description Spare part number

Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit. See Cable Kit on page 22 for more Cable Kit spare part
information.

 

High-speed 56K modem for use in all countries and regions except Australia and New Zealand 510100-001

High-speed 56K modem for use in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. DVD-ROM drive (see DVD-ROM drive on page 43)

d. Speakers (see Speakers on page 46)

e. Palm rest (see Palm rest on page 48)

f. Top cover (see Top cover on page 67)

Remove the modem module:

1. Position the computer right-side up with the front toward you.

2. Remove the two PM2.5×5.0 screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to disconnect it from the system board.

4. Disconnect the modem cable (3) from the modem module.

Component replacement procedures 69



5. Remove the modem module.

Reverse this procedure to install the modem module.
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System board
NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System board (includes replacement thermal material) 614524-001

Before removing the system board, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. Speakers (see Speakers on page 46)

d. Palm rest (see Palm rest on page 48)

e. WLAN module (see WLAN module on page 54)

f. Solid-state module (see Solid-state module on page 50)

g. DVD-ROM drive (see DVD-ROM drive on page 43)

h. Display assembly (see Display assembly on page 62)

i. Top cover (see Top cover on page 67)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 41)

● WLAN module (see WLAN module on page 54)

● Modem module (see Modem module on page 69)

● Processor (see Processor on page 60)

Remove the system board:

1. Position the computer right-side up with the front toward you.

2. Disconnect the USB board cable (1) from the system board.

3. Disconnect the power connector cable (2).

4. Remove the slotted T8 2.5×5.0 screw (3) that secures the system board to the base enclosure.
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5. Use the optical drive connector (4) to lift the right side (5) of the system board.

6. Remove the system board (6) at an angle.

Reverse this procedure to install the system board.
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USB connector board

Description Spare part number

USB board with cable 599524-001

Before removing the USB connector assembly, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. DVD-ROM drive (see DVD-ROM drive on page 43)

d. Speakers (see Speakers on page 46)

e. Palm rest (see Palm rest on page 48)

f. Solid-state module (see Solid-state module on page 50)

g. Display assembly (see Display assembly on page 62)

h. Top cover (see Top cover on page 67)

i. System board (see System board on page 71)

Remove the USB connector assembly:

1. Position the computer right-side up with the right side toward you.

2. Release the USB connector board cable from the base enclosure clips and routing channel (1).
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3. Remove the USB connector assembly (2) from the base enclosure.

Reverse this procedure to install the USB connector assembly.
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Modem module cable
NOTE: The modem module cable with RJ-11 connector is included in the Cable Kit on page 22, part
number 599525-001.

Before removing the modem module cable, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. DVD-ROM drive (see DVD-ROM drive on page 43)

d. Heat sink and fan (see Heat sink and fan on page 57)

e. Speakers (see Speakers on page 46)

f. Palm rest (see Palm rest on page 48)

g. Solid-state module (see Solid-state module on page 50)

h. Display assembly (see Display assembly on page 62)

i. Top cover (see Top cover on page 67)

j. System board (see System board on page 71)

k. USB connector board and cable (see USB connector board on page 73)

Remove the modem cable.

1. Position the computer right-side up with the front toward you.

2. Release the RJ-11 connector from the base enclosure clips (1).
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3. Remove the modem cable (2) from the routing channel in the base enclosure.

4. Remove the modem cable.

Reverse this procedure to install the modem cable.
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Power connector cable
NOTE: The power connector cable (DC power) is included in the Cable Kit on page 22, part number
599525-001.

Before removing the power connector cable, follow these steps:

1. Shut down the computer.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Switch cover (see Switch cover on page 37)

b. Keyboard (see Keyboard on page 39)

c. DVD-ROM drive (see DVD-ROM drive on page 43)

d. Heat sink and fan (see Heat sink and fan on page 57)

e. Speakers (see Speakers on page 46)

f. Palm rest (see Palm rest on page 48)

g. Solid-state module (see Solid-state module on page 50)

h. Display assembly (see Display assembly on page 62)

i. Top cover (see Top cover on page 67)

j. System board (see System board on page 71)

k. USB connector board and cable (see USB connector board on page 73)

Remove the power connector cable.

1. Position the computer right-side up with the front toward you.
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2. Disconnect the power connector cable from the base enclosure (1), and then remove the cable
from the routing channel (2) in the base enclosure.

3. Remove the power connector cable.

Reverse this procedure to install the power connector cable.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Starting Computer Setup 79



Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

To select a menu or a menu item, use the fn key and the keyboard arrow keys and then press
enter.

NOTE: You can use either a pointing device (TouchPad or USB mouse) or the keyboard to
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.
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4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.
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Select To do this

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the Express Boot Popup delay in seconds.

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable PXE Internal NIC boot (disabled by
default).

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only; enabled by default). When enabled, the
processor can disable some virus code execution,
which helps to improve computer security.

NOTE: Availability of the options above varies by
computer model.

● Enable/disable LAN Power Save (disabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable Wake on USB (disabled by default).

● Enable/disable Num lk on at boot (disabled by default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable the embedded WLAN device (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the optical disc drive (enabled by
default).

● Enable/disable an audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

Port Options NOTE: All port options are enabled by default.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the ExpressCard slot.

● Enable/disable the eSATA port.
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6 Specifications

Computer specifications
Dimensions

Depth 22.81 cm (8.98 in)

Width 32.2 cm (12.68 in)

Height (front to rear) 27.5 to 35.5 cm (1.08 to 1.40 in)

Weight  

● With 6-cell battery, one memory module, and optical disk drive < 2.07 kg (4.58 lbs)

● With 6-cell battery, one memory module; without optical disk drive < 1.93 kg (4.27 lbs )

Input power

Operating voltage 18.5 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C (32°F to 95°F)

Nonoperating -20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration
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Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25
oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/
min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

33.8-cm (13.3-in) display specifications
Dimensions  

Height 20.83 cm (8.2 in)

Width 27.94 cm (11.0 in)

Diagonal 33.6 cm (13.3 in)

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution  

Pitch 0.279 × 0.279 mm

Format SD: 1280 × 800; HD: 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120/-40° vertical (typical)
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Solid-state module specifications
 2-GB* 4-GB* 8-GB*

Dimensions  

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 15 g 15 g 15 g

Interface type SATA II SATA II SATA II

Transfer rate    

Sustained read 54 MB/sec 102 MB/sec 102 MB/sec

Sustained write 33 MB/sec 55 MB/sec 57 MB/sec

Operating temperature 0°C to 70°C

(32°F to 158°F)

0°C to 70°C

(32°F to 158°F)

0°C to 70°C

(32°F to 158°F)

*1 GB = 1 billion bytes when referring to solid-state module storage capacity. Actual accessible
capacity is less. Actual drive specifications may differ slightly.

 

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.  
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DVD-ROM drive specifications
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2),

CD Digital Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode
2, Form 1 and Form 2), CD-R, CD-RW, Photo CD (single and multisession),
CD-Bridge

Random access time

DVD < 125 ms

CD < 100 ms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s
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System resource specifications
You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources that are accessible from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings:

1. Select Start > Control Panel.

2. Click Device Manager.

3. On the View menu, click one of the following:

● Resources by type

● Resources by connection
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7 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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8 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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